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1. User Registration Tips 
 
  

1.1  When creating a new user the Last Name and email address must be the same in 
FFAVORS and eAuthentication  

1.2. When adding a new user in FFAVORS,  the User ID filed is still a required field to 
be entered by the DLA System Administrator.   

1.3. Most common issues with registration: 
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a. When completing eAuth registration page, user cannot use Internet Explorer 7.  
Internet Explorer 8 is recommended or IE 9 in compatibility mode. 

b. eAuth registration email is blocked by users mail server.  Need to allow emails 
from : eAuthHelpDesk@ftc.usda.gov and eems.support@ocio.usda.gov . 

c. New user does not select the “ACTIVATE MY ACCOUNT” within the 
notification from eAuthentication. This must be done within 7 days of the creation 
of the eAuthentication account.  

d. User enters a different last name/email address in eAuthentication than what is in 
FFAVORS.  

e. Issue with the eAuthentication web site during the users registration process that 
requires user to contact the eAuth help Desk at 800-457-3642. 

 

1.4. Registration emails that are sent to users when their FFAVORS profile is created are 
for that specific user only and SHOULD NOT BE SHARED. If a user tries to register 
using another person’s registration email it will not work.  
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2. Questions relating to Customer Account Creation 
2.1 Q. Who can use eAuthentication? 

A. Any public customer who would like to conduct business with the USDA can 
establish an eAuthentication account on this Web site. However, an account with Level 2 
access is required to conduct official electronic business transactions with the USDA via 
the Internet. USDA Employees may register for a Public Customer eAuthentication 
Account ONLY when they would like to conduct PERSONAL business with the USDA. 
Do NOT register for a Customer Account if you need an Employee Account! Only 
Employee accounts can be used successfully for official business at USDA websites.  
 
If you are a USDA Federal Employee , you should continue with the USDA 
eAuthentication Employee Create an Account process 

2.2 Q. Do I have to submit an application for an account for Level 1 access and then 
submit another one for Level 2 access? 

A. You only need a single account to do business with the USDA at any eAuthentication-
protected website. However, an account with Level 2 access is required to conduct 
official electronic business transactions with the USDA via the Internet. 

mailto:eAuthHelpDesk@ftc.usda.gov
mailto:eems.support@ocio.usda.gov
https://www.eauth.usda.gov/MainPages/eauthEmployeeCreateAccount.aspx
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2.3 Q. I signed up for an eAuthentication account with Level 1 or 2 access. What is my 
next required step? 

A. All levels of eAuthentication access require you follow the directions in the 
Confirmation email you received at the email address provided in your profile. 

2.4 Q. How long do I have to respond to the Confirmation email? 

A. You have a maximum of seven (7) days to respond to the Confirmation email, or your 
account will be deleted. You can respond by using the link provided in the Confirmation 
email. 

2.5 Q. It's after the seven (7) day period and I didn't respond in time. What now? 

A. After seven (7) days the account you created was deleted. You must start the entire 
process over to create a new eAuthentication account. You will need to use a new User 
ID. You cannot use your previously selected User ID. You must follow the instructions 
on your confirmation email within the required seven (7) day time frame. 

2.6 Q. If my account is deleted because I didn't respond within the seven (7) day limit, 
can I use the same User ID? 

A. No, that User ID cannot be used again. You must create a new unique User ID. 

2.7 Q. The Customer Profile won't accept the User ID I have created. Why? 

A. The User ID is already in use by someone else. Since User IDs are required to be 
unique, you cannot use the same one. 

2.8 Q. I don't see a confirmation email from the USDA, but I am within the seven (7) 
day window. 

A. It is common that anti-spam software in your email software or at your email servers 
can interfere with the USDA's confirmation email message to you. Look in folders other 
than your "Inbox" such as "SPAM", "Junk Mail", "Bulk", or "Suspected SPAM". In 
addition, some Internet Service Providers include a service that captures suspected SPAM 
and maintains these files outside of your individual email account. 

If after 24 hours you do not receive the confirmation email: 

• Turn off your email provider's filters.  
• Turn off your personal email filter settings.  
• If it has been more than one day since the account was created and you have 

searched, but can't find the confirmation email, then be sure that you don't have 
any filters, forwarding, or anti-spam measures that might affect your incoming 
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mail. Once you've completed that, then create a new account and be ready to 
respond to the confirmation email. Be advised that you will not be able to use the 
same User ID. 

2.9 Q. I never found my first confirmation email, so as you suggested, I turned off my 
anti-spam and filters and created another account. It's been a day and still no 
confirmation email. What now? 

A. Call the eAuthentication Help Desk at 800-457-3642 and explain the situation in 
detail. Provide your first and last names and the User ID for any accounts you created. 
Since you now have multiple accounts, please identify the single account that you wish to 
use and authorize the Help Desk to disable the others. 

2.10 Q. I can't get the link in the Confirmation email to work. What now? 

A. At the bottom of the Confirmation email is long string of alphabetic and numeric 
characters. Copy and paste the entire string of characters into the address window of your 
browser and press the Enter key. 

2.11 Q. I couldn't get either the link in the Confirmation email or the long string 
technique to work. What now? 

A. We suggest you forward the entire Confirmation email you received to the ITS 
Service Desk for troubleshooting at eAuthHelpDesk@ftc.usda.gov. Please include your 
User ID and the date you attempted to confirm your email. 

2.12 Q. I signed up for an account with Level 1 access and confirmed my email 
address. What now? 

A. Your account is ready to use! You can access any USDA application that requires an 
account with Level 1 access.   The receiving application may require a user profile within 
its data base to ensure access. 

2.13 Q. I signed up for an account with Level 2 access and confirmed my email 
address. What now? 

A. You must visit a local USDA Service Center in person for identity proofing. (Find an 
LRA) Take your government-issued photo ID to the nearest USDA Service Center most 
convenient to you for identity proofing 

The government-issued photo IDs that are accepted for eAuthentication Level 2 account 
activation are: 

• State- or Province-issued Driver's License or Photo Identification card from the 
United States or Canada 

mailto:eAuthHelpDesk@ftc.usda.gov
http://offices.sc.egov.usda.gov/locator/app?type=lra
http://offices.sc.egov.usda.gov/locator/app?type=lra
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• US Military or US Federal Government employment PIV/CAC (Smart) 
identification card (DoD, DoS, DHS, etc.) 

• Valid passport from one of the following countries: Andorra, Australia, Austria, 
Belgium, Bermuda, Brunei, Canada, Czech Republic, Denmark, Estonia, Finland, 
France, Germany, Greece, Guam, Hungary, Iceland, Ireland, Italy, Japan, Latvia, 
Liechtenstein, Lithuania, Luxembourg, Malta, Mariana Islands, the Marshall 
Islands, Mexico, Micronesia, Monaco, the Netherlands, New Zealand, Norway, 
Portugal, San Marino, Singapore, Slovak Republic, Slovenia, South Korea 
(Republic of Korea), Spain, Sweden, Switzerland, the United Kingdom or the 
United States of America. 

Note: Your first and last names must appear exactly as they appear on your government 
issued photo ID that you present at the Service Center. 

2.14 Q. I logged into my Level 2 account and was prompted to answer questions. Why 
did this happen? 

A. USDA eAuthentication is trying to make it easier for all customers to retrieve their 
forgotten password and increase account security. The security questions and answers are 
a way to make your information more personal (memorable) and more difficult to 
research. 

If you forget your password in the future, you will now be asked to answer these 
questions instead of entering your original security attributes. 

2.15 Q. How do I locate my nearest USDA Service Center? 

A. Please browse to http://offices.sc.egov.usda.gov/locator/app?type=lra. This site will 
help you to identify a USDA Service Center with an LRA, and will provide you with 
contact information and map directions to help you find it. 

2.16 Q. I am a federal employee from an agency other than the USDA, why would I 
need to register for an account with Level 1 or 2 access? 

A. Two possible reasons for you to obtain an eAuthentication account would be: 1) you 
would like to conduct personal business transactions with the USDA or 2) you need to 
access a Web site protected by eAuthentication that requires an eAuthentication account 
with Level 2 access. 
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3. Questions relating to your password or User ID 

3.1 Q. I have an account with Level 1 access. I’ve forgotten my password. How do I 
obtain a password reset? 

http://offices.sc.egov.usda.gov/locator/app?type=lra
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A. Please follow the steps below to reset your forgotten password: 

1. Go to link : Home 
2. Click on Update your account in the Quick Links box. 
3. Click the  I Agree  button on the warning page 
4. Below the Password field, click on the Forgot your Password? Link 
5. Click the Continue button 
6. Follow the steps to Change My eAuthentication Password 
 
A. You can visit the General Help and follow the instructions under ‘Have you forgotten 
your User ID or password?’ 
 
3.2 Q. I have an account with Level 2 access. I’ve forgotten my password. How do I 
obtain a password reset? 
 
A. Please follow the steps below to reset your forgotten password: 

1. Go to link : Home 
2. Click on Update your account in the Quick Links box. 
3. Click the I Agree button on the warning page 
4. Below the Password field, click on the Forgot your Password? Link 
5. Click the Continue button 
6. Follow the steps to Change My eAuthentication Password 
 

A. You can visit the General Help and follow the instructions under ‘Have you forgotten 
your User ID or password?’ 

 
Please contact the ITS Service Desk at eAuthHelpDesk@ftc.usda.gov or call 800-457-
3642 for further assistance. Include your User ID, First name, Last name, and email 
address. 

3.3 Q. I cannot remember my User ID. How can I recover it? 

A. Please follow the steps below to recover your User ID: 

1. Go to link : Home 
2. Click on Update your account in the Quick Links box. 
3. Click the  I Agree  button on the warning page 
4. Below the User ID field, click on the Forgot your User ID? Link 
5. Click the Continue button 
6. Follow the steps to Change My eAuthentication Password. 

A. You can visit the General Help and follow the instructions under ‘Have you forgotten 
your User ID or password?’ 

https://www.eauth.usda.gov/mainPages/index.aspx
https://www.eauth.usda.gov/MainPages/eauthHelp.aspx
https://www.eauth.usda.gov/mainPages/index.aspx
https://www.eauth.usda.gov/MainPages/eauthHelp.aspx
mailto:eAuthHelpDesk@ftc.usda.gov
https://www.eauth.usda.gov/mainPages/index.aspx
https://www.eauth.usda.gov/MainPages/eauthHelp.aspx
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Please contact the ITS Service Desk at eAuthHelpDesk@ftc.usda.gov or call 800-457-
3642 for further assistance. 

  

mailto:eAuthHelpDesk@ftc.usda.gov
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3.4 Q. What are the "Reset My Forgotten Password" feature and the new "Retrieve My 
Forgotten User ID" feature? 

A. We have developed a new process to make it easier for you to reset your forgotten 
password and retrieve your forgotten User ID. The new process to reset your password 
utilizes questions that you may select, and which only you know the answers to. The new 
process for retrieving your User ID will allow you to go online and follow the simple 
steps for getting your User ID without the assistance of the Help Desk. An email will be 
sent to your email address on record 

The following are components of the new features: 

• New security questions that make it easier for you to retrieve your password. 
• Online functionality for you to retrieve your User ID. 
• Enhanced Security 

New security questions that make it easier for you to retrieve your password. 

Online functionality for you to retrieve your User ID. 

Enhanced Security 

Read the following documentations to learn more about the eAuthentication process:   

• User Guides & Documentation 
 

Please contact the ITS Service Desk at eAuthHelpDesk@ftc.usda.gov or call 800-457-
3642 for further assistance. 

3.5 Q. How will the "Reset My Forgotten Password" feature and the new "Retrieve My 
Forgotten User ID" feature affect me? 

A. The eAuthentication system will eventually prompt you to select your choice of 
security questions, and to provide answers to them. This is a quick and easy process that 
increases security for all USDA eAuthentication accounts, and only takes about ten 
minutes of your time 

3.6 Q. Why am I being prompted to answer new security questions when logging into 
my eAuthentication account? 

A. To ensure a higher level of security for your account information, the eAuthentication 
team is redesigning the "Reset My Forgotten Password" components of the 
eAuthentication system. You will be prompted to do this only once. Thereafter, the 
system will provide you with opportunities to update this information if you wish to do 

https://www.eauth.usda.gov/MainPages/eAuthUserGuides.aspx
mailto:eAuthHelpDesk@ftc.usda.gov
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so. Please choose and answer four (4) security questions from the list of questions 
provided. Continue through the steps to the completion page. 

3.7 Q. Why does the eAuthentication system require such complicated passwords? 

A. eAuthentication protects web sites that involve submitting personal and private 
information as well as financial transactions via the Internet. eAuthentication security 
standards are consistent with those established by the National Institutes for Standards 
and Technology (NIST), which determines the standards for the Federal Government. 

3.8 Q. Why is the complexity of my password important to Protecting Privacy at 
USDA? 

A. The USDA eAuthentication Service enables USDA customers to confidently share 
data and conduct official business transactions with USDA electronically via the Internet. 

To learn more about Protecting Privacy at USDA, read the Privacy Presentation for End 
Users. 

3.9 Q. What are the criteria and rules governing passwords within the eAuthentication 
system? 

A. Please create a password that you will remember. Your password is case sensitive: 

All passwords in eAuthentication (for Level 1 and Level 2 accounts) must adhere to the 
following criteria: Required Character: 

• 12 - 24 characters long 

• Have at least one of these special characters 
o 0 1 2 3 4 5 6 7 8 9 
o ! # $ % = + : ; , ? ~ * - 

• No spaces allowed 

Restricted Information (Do Not Use) 

• Dictionary Words 
• Profile Information 
• Mother's Maiden Name, Date of Birth, PIN, Your Name, Address, Phone 

Number,  Email, etc 
• Your password will expire after 60 days 
• Your previous 24 passwords may not be re-used 

 
Click here to learn more about creating a strong password for your eAuth account 

• Have at least one uppercase letter (A, B, C, etc.) 
• Have at least one lowercase letter (a, b, c, etc.) 

https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_SecurityResponsibilitiesForEndUsers.pdf
https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_SecurityResponsibilitiesForEndUsers.pdf
https://www.eauth.usda.gov/_GlobalAssets/Documents/USDA_eAuth_TipsForCreatingAStrongPassword.pdf


FFAVORS FAQs and Tips 
 

 
Top of the Document 

4. Questions relating to Web Browsers 
 

4.1 Q. What kind of browser do you recommend using? 
 
A. It is recommended that you use Internet Explorer 8. Also, it is recommended that you 
use a browser that supports 128-bit encryption, accepts cookies, and is Javascript enabled 
 

For further information about your program and/or download instructions, please access 
the following sites: 

For Internet Explorer - http://www.microsoft.com/windows/ie/default.asp 
  

4.2 Q. I use America On Line (AOL) and I am still having trouble. What should I do? 

A. If you are using an AOL browser and/or email client, please follow the steps provided 
below: 

1. Connect to the AOL Program 
2. Once connected, minimize your AOL browser window 
3. Open a new Internet Explorer or Netscape window 
4. Validate that you are running a compatible version of the software 
5. Click on the “Help” button from the menu bar 
6. Select the “About” feature for your program from the drop down menu 
7. Review the dialog box that will display the version of the software that you are 

currently running 
8. If you are running an out dated version of the software, install new a version of 

Internet Explorer  

4.3 Q. I useWebTV and I am having trouble. What should I do? 

A. If you are using WebTV, please note that this is not compatible with many USDA 
sites. Thus, we do not provide support when it is used. Please use an alternate program 
(e.g. Internet Explorer) 

4.4 Q. I keep getting re-directed back to the login screen after I click the “Login” 
button. 

A. Enabling “Compatibility View” in Internet Explorer may resolve this issue. If it does 
not, please contact the eAuthentication helpdesk at 800-457-3642. 

To set Compatibility View in IE 8: 

http://www.microsoft.com/windows/ie/default.asp
http://www.microsoft.com/windows/ie/default.asp
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1. Start Internet Explorer 8 
2. On the Tools menu, click Compatibility View Settings 

i. Note: If Compatibility View Settings is not available, you may need to 
contact your network administrator for assistance. 

3. Select the box that says Display all websites in Compatibility View and then click 
Close 

To set Compatibility View in IE 9:  
Click the Compatibility View icon on the IE9 menu OR follow the steps for IE8 
(above). Note: If the IE9 menu is not displayed, press the ALT key on your 
keyboard to display it 
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5.  FFAVORS web specific questions 
 

5.1 Q. Who do I contact now with FFAVORS web questions 

A.  Your DLA account representatives are still the go to people for your questions 
concerning FFAVORS Web.   They will be able to assist you as they have and if not, they 
will know where and how to direct your questions. 

The one area they cannot help will be with questions concerning your eAuthentication 
IDs and passwords to get into the system.  All questions concerning that topic need to be 
addressed with the eAuthentication help desk.  Look at the questions under question 2 of 
this document for possible answers for these.  

5.2 Q. If I am unsure of who to contact, is there a general email address that I can 
send a question to? 
 

A. Yes, you can send questions to paamagic@dla.mil 
 

5.3 Q. How do I access FFAVORS web? 
 

A. Follow the these steps: 

Please note that the recommended browser for eAuth/FFAVORS is Internet Explorer 8. If 
using Internet Explorer 9, you will need to set compatibility (add usda.gov on 
Tools/Compatibility View Settings menu).  

o Log into USDA FFAVORS Web 
o Navigate to: http://www.fns.usda.gov/fdd/ffavors.htm  
o Select the Log into FFAVORS web link under the 'I want to' section. 
o On the blue warning page, read and click the 'I Agree' button. 

mailto:paamagic@dla.mil
http://www.fns.usda.gov/fdd/ffavors.htm
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o On the eAuthentication Login page, enter your eAuth ID and password in 
the User ID and Password fields. 

o If you have multiple FFAVORS accounts, you will be prompted to choose from a 
list which FFAVORS account you want to be associated to the eAuth ID you 
logged in as. This will only occur the first time you log in for a given eAuth ID. 
Only accounts not previously associated will appear as viable options. 

Top of the Document   
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6. Steps to obtain the eAuth Level 1 ID for FFAVORS 
 

Step 1:  Obtaining eAuth Level 1 ID    

Access this link 

https://identitymanager.eems.usda.gov/registration/selfRegistrationForm.aspx?level=1  

 

Step 2:  Complete screen.  Click [Continue] button 

 

  

https://identitymanager.eems.usda.gov/registration/selfRegistrationForm.aspx?level=1
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Step 3:   Verify data entered.  If ok, click [Submit] 

 

If you get any error returned instead of the above, ‘Step 2 of 4’ message, close browser and 
try in 20 minutes.  If still have error page, please contact the eAuth Help Desk at 800-457-
3642. 
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Step 4:  If no issues where found such as Dictionary of profile words used, you will receive 
the confirmation screen below: 

 

If you get any error returned instead of the above, ‘Step 3 of 4’ message, close browser 
and try in 20 minutes.  If still have error page, please contact the eAuth Help Desk at 
800-457-3642.Step 5:    

 As mentioned in the screen above.   Confirmation email is sent to the email addressed used 
in Step 2 above.   The email will come from one of two email addresses: 
eAuthHelpDesk@ftc.usda.gov or eems.support@ocio.usda.gov .     

 

If not received within a day:  

Check other folders such as SPAM, JUNK 

 If not found:    CALL 800-457-3642 

  

mailto:eAuthHelpDesk@ftc.usda.gov
mailto:eems.support@ocio.usda.gov
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Step 5:   Email is received. 

 

 

Step 6:   Click on the link in the email labeled:  Activate My Account 

If your link within the email does not working, copy and paste the URL into the browser as 
mentioned in the email. 

 

Step 7:   Successful Activation 

If the activation worked you will receive the screen: 

 

 

If receiving error message saying an error has occurred or other, call 800-457-3642 

Top of the Document 
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7. Login Issues encountered 

7.1 Are there any potential error conditions I might encounter that have solutions? 

A. Yes, there are some potential error conditions that a user could hit when attempting to 
access FAVORS web.  The three most common are outlined below with the appropriate 
resolutions. 

Access Issue 1: Server Error in ‘/Login’ Application 

What user will see: 

 

Cause:  Newer versions of Internet Explorer are not currently compatible with 
FFAVORS. 

Resolution:  This error will be corrected by allowing Internet Explorer to run 
USDA.GOV web sites in Compatibility mode. 

Compatibility Mode: 

Open Browser (IE) 
Hold the [Alt] key and hit ‘T’ 
Gray window under Tools opens 
Click ‘Compatibility View Settings’ 
In the window labeled ‘Add this website’ enter/ensure you see   usda.gov  
Click the [Add] button 
Click the [Close] button 
Log into FFAVORS  http://www.fns.usda.gov/fdd/ffavors.htm  

  

http://www.fns.usda.gov/fdd/ffavors.htm
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Access Issue 2:  FFAVORS Login Failure  

What user will see: 

 

Cause:  The last name and/or email data do not match between the FFAVORS application 
and eAuth. 

Resolution: Verify what was used to create the eAuth ID and then Contact your 
FFAVORS account rep to verify or email paamagic@dla.mil the issue.   Once both 
systems are brought in alignment, user will gain access. 

 

Access Issue 3: eAuthentication ‘Login failed’ message 

What the user will see: 

 

Cause:  This has three possible reason ranging from user mistyping ID or password, 
Registration steps not complete or system issue with eAuthentication. 

Resolution:  Follow the steps below. 

a) Verify the ID and Passwords were entered correctly (DO NOT CUT & PASTE) 

b) Verify user successfully completed the steps above to obtian and activate eAuth 
user ID 

mailto:paamagic@dla.mil
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a. See step 6 below for the entire process 

c) Try accessing the ‘Update your account’ link to see if ID and password will access 
the EEMS Identity Manager pages. 

a. If user can access EEMS but not FFAVORS 

i. Might be compatibility issue: 

1. Open Browser (IE) 
2. Hold the [Alt] key and hit ‘T’ 
3. Gray window under Tools opens 
4. Click ‘Compatibility View Settings’ 
5. In the window labeled ‘Add this website’ enter/ensure you see   

usda.gov  
6. Click the [Add] button 
7. Click the [Close] button 
8. Log into FFAVORS  http://www.fns.usda.gov/fdd/ffavors.htm  

 
ii. If still cannot access FFAVORS 

1. Most likely an error occurred within eAuth that prevented the 
user ID from syncing to the appropriate sub systems.  User 
must call help desk to resolve at 800-457-3642 

 
b. If user can’t access either, use the correct link under ‘I Want To…’ (upper 

right corner) 

i. Reset My Forgotten Password 

ii. Retrieve My Forgotten User ID 

 
c. If still can’t get into either EEMS or FFAVORS call eAuth HD 800-457-3642.  

Must be issue with eAuth account. 
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8. eAuthentication Check Browser and Settings 

 

8.1 Identify the version of Internet Explorer you are using: 

1) Open Internet Explorer  

  If you are not able to locate the IE icon on your Windows Start Menu or 
Desktop you can click on Start – then Run and type in “iexplore.exe” to run 
Internet Explorer directly. 
 

2) Press ALT-H to access the Help menu 

 
3) Select “About Internet Explorer” from the help menu. 

This screen should help you identify the version of Internet Explorer you are using. 

8.2 Set Compatibility Mode for your IE version 

IE 9 and Higher 

1) Browse to https://www.eauth.usda.gov/ 

2) Press ALT-T to access the Tools Menu and select “Compatibility View Settings”. 

 

Click the check box for “Display all websites in Compatibility View” then click 
the Close button 

 

https://www.eauth.usda.gov/
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3) Continue on and complete the settings changes for all versions of Internet 
Explorer 5.5 and higher.  

IE 5.5 and Higher 

1) Press ALT-T to access the “Tools” menu and select “Internet Options”. 

 

 
 

2) Select the “Privacy” tab and click on “Advanced” 
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3) Under “First-Party Cookies” click “Accept”.  Check the box next to “Always 
allow session cookies”. Click “OK”. 

 

 
 

4) Select the “Advanced Tab” and scroll down in the “Settings” window to the 
“Security” section. 
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5) Check the boxes next to “Use SSL 2.0”, “Use SSL 3.0” and “Use TLS 1.0” then 
click OK. 

 

 
 

6) Press ALT-F to access the File Menu and select Exit. 

 

 
 

7) Access the FFAVORS  Home Page at http://www.fns.usda.gov/fdd/ffavors.htm 
and log into FFAVORS. 
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